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Canadian Compliance Statement:
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Chapter 1: Overview
The AT16 A-Net Output Card (A-Net Card) lets you use Aviom 
Personal Mixers and other Aviom Pro16 Series™ devices with 
the VENUE Mix Rack or the VENUE SC48™ console. 

You can install up to two A-Net Cards in a single Mix Rack or 
a single SC48, allowing for two discrete 16-channel networks.

This guide covers installation and connection of the A-Net 
Card to the Mix Rack and the SC48, as well as signal routing to 
the A-Net Card from VENUE D-Show® software . 

A-Net Card Option Components
The A-Net Card option includes the following items: 

• A-Net Card

• Mounting screws

• Registration Information Card

• This guide

A-Net Card Capabilities and Features
The A-Net Card option provides the following:

• Transmission of 16 channels of 24-bit, 48 kHz audio per 
card to any Aviom Pro16 Series networked device

• Signal status display on front of card

• Full control of A-Net parameters from VENUE D-Show 
software 

• Connects to Aviom hardware over inexpensive Cat-5e 
Ethernet cable (purchased separately)

• Rugged Neutrik EtherCon® RJ45 connector for durability
System Requirements

VENUE System

One of the following is required to use the A-Net Card option:

• A VENUE Mix Rack with an available output card slot 

– or –

• A VENUE SC48 console with an available output card slot

For complete system requirements, visit www.avid.com.

Aviom Components

The A-Net Card is compatible with Aviom Personal Mixers 
and other Pro16 Series devices.

For instructions on using an Aviom Pro16 Series device with 
your system, refer to the documentation that comes with the 
Aviom device.

Cables

Supported Aviom Pro16 Series devices connect to the A-Net 
Card using unshielded Cat-5e Ethernet cables (not included). 
The maximum supported cable length for each device is 500 ft 
(150m).

Compatibility Information

Avid can only assure compatibility and provide support for 
hardware and software it has tested and approved. 

For a list of-qualified third-party devices, visit www.avid.com.

The Aviom A-16 Personal Monitor Mixing System (now 
discontinued) is not supported by the A-Net Card. Use the 
A-16II Personal Mixers with the A-Net Card.
Chapter 1: Overview 1



Conventions Used in This Guide
All VENUE guides use the following conventions to indicate 
menu choices and key commands in VENUE D-Show and 
Pro Tools software:
:

The names of Commands, Options, and Settings that appear 
on-screen are in a different font.

The following symbols are used to highlight important 
information:

Convention Action

File > Save Session In Pro Tools, choose Save 
Session from the File menu.

Options > System Config In the D-Show software 
screen, click Options to dis-
play the Options page, then 
click the System Config tab.

Ctrl+N Hold down the Control key 
and press the N key.

Ctrl-click Hold down the Control key 
and click the mouse button.

User Tips are helpful hints for getting the 
most from your VENUE system.

Important Notices include information that 
could affect data or performance.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
VENUE or Pro Tools Guides.
AT16 A-Net Output Card Guide2



Chapter 2: Installing an A-Net Card
This chapter provides information on installing an A-Net Card 
in a Mix Rack or an SC48 console, as well as connecting A-Net 
devices to an A-Net Card.

For instructions on installing an A-Net Card in your Mix Rack, 
see “Installing an A-Net Card in Mix Rack” on page 3.

For instructions on installing an A-Net Card in your SC48, see 
“Installing an A-Net Output Card in SC48” on page 6.

Installing an A-Net Card in Mix Rack
Your Mix Rack has two available output card slots, slots D and 
E. A-Net Cards can be installed in either or both slots. These 
instructions assume that you have an Analog Output Card 
(AO16) in slot D and that slot E is empty.

To install an A-Net Card:

1  Shut down the VENUE system, and turn off power to the 
Mix Rack. 

If you are replacing an A-Net Card or are removing an 
AO16 card, you must first remove one of the cards. See the 
Venue Service Guide for more information on removing and 
replacing cards.
2  Disconnect all cables from the Mix Rack. Remove the Mix 
Rack’s front panel cover by unscrewing its mounting screws 
(#1 Phillips).

Mix Rack front panel

Mounting screws (remove all)
Chapter 2: Installing an A-Net Card 3



3  On the Mix Rack’s back panel, locate output slot E.

4  Remove the card slot cover from the output slot by remov-
ing the four screws holding it in place. Keep the screws nearby 
for securing the card to the Mix Rack later.

5  Remove the card from its packing material. Hold the card by 
its edges.

6  Gently slide the card into output slot E
.

Mix Rack back panel

A-Net Card showing ribbon cable connectors 

Installing an A-Net Card in Mix Rack

Output
Slot E
(remove
cover)

Used card socket

Chassis mounting screw holeUnused card socket
AT16 A-Net Output Card Guide4
7  When the card is seated in its slot, use the captive thumb-
screws to secure the A-Net Card to Mix Rack’s chassis in the 
front of Mix Rack. 

8  Secure the card to the front panel of Mix Rack using the four 
mounting screws you removed earlier.

9  Find the topmost Hub48 board ribbon cable. The Hub48 
board’s five ribbon cables connect to the input and output 
cards.

10  Connect the ribbon cable to the card socket that is facing 
out.

Securing an A-Net Card to Mix Rack’s back panel

Finding topmost Hub48 ribbon cable

Only one of the card sockets on the A-Net Card is con-
nected to Mix Rack’s ribbon cable connector. Make sure 
to use the card socket that is facing out, not the card 
socket that is facing up.

Hub48
Board



Make sure the pins on the socket are correctly aligned with the 
ribbon cable connector. Secure the connection by moving the 
retaining clips on each side of the socket connector inward. 
Check to make sure the ribbon cable is connected securely.
.

Completing and Confirming Installation

To complete and confirm installation:

1  Reattach the Mix Rack’s front panel.

2  Reconnect the power and any audio cables to the Mix Rack.

3  Turn on your VENUE system.

4  Go to the Options page and click the Devices tab to view 
your system hardware status. The newly installed A-Net Card 
should be displayed.

\

A correctly connected A-Net Card

If the A-Net Card does not appear in the Mix Rack graphic, 
check the ribbon cable connection. Disconnect and recon-
nect the ribbon cable to the Output Card, making sure to 
seat the connector properly in its card socket.

Detail of Devices tab indicating presence of an A-Net Card
5  In the standalone software, right-click the Mix Rack graphic 
to see your Mix Rack’s input and output card configuration. 
Your A-Net Card appears as “E: A-Net Output Card” in the 
pop-up menu.

6  Go to the Patchbay page and click the Stage tab to verify 
that “A-Net Card” outputs appear in the patchbay.

Detail of the standalone software Devices tab showing an A-Net Card 
pop-up menu
Chapter 2: Installing an A-Net Card 5



Installing an A-Net Output Card in 
SC48
Your SC48 has two available output card slots, slots D and E. 
A-Net Cards can be installed in either or both slots. These in-
structions assume that you have an Analog Output Card 
(AO16) in slot D and that slot E is empty.

1  Shut down your system, and turn off power to the SC48. 

2  Disconnect any power cables from the SC48, as well as any 
other audio cables that may get in your way.

3  On the back panel of the SC48, locate output slot E.

4  Remove the four screws holding the card slot cover in place. 
You can use a flathead screwdriver to pry the cover away from 
the output slot after removing the screws.

Keep the screws nearby for securing the A-Net card to the 
SC48. 

5  Clip the cable tie to free the ribbon cable that is attached to 
the inside of the card slot cover.

Left side of the SC48 back panel

Use care when prying away the card slot cover. The ribbon 
cable that you need to connect to the output card is at-
tached to the inside of the card slot cover.

Clip the cable tie to free the ribbon cable

Slot E (remove card slot cover)
AT16 A-Net Output Card Guide6
6  Remove the A-Net Card from its packing material. Hold the 
card by its edges.

7  Connect the ribbon cable to the card socket that is facing 
out. Make sure the pins on the socket are correctly aligned 
with the ribbon cable connector. The retaining clips on each 
side of the socket connector automatically close when the ca-
ble connector is properly seated. Check to make sure the rib-
bon cable is connected securely.
.

8  Slide the A-Net Card into the slot, firmly pressing on both 
ends of the card so that it fits snugly in the slot.

9  Secure the card to the rear panel using the four screws you 
removed earlier.

A-Net Card showing ribbon cable connectors 

Connecting the ribbon cable to the card socket facing out

Installing the A-Net Card

Used Card socket

Unused card socket



Completing and Confirming Installation

To complete and confirm installation:

1  Reconnect the power cable and any other cables to the 
SC48.

2  Turn on your VENUE system.

3  Go to the Options page and click the Devices tab to view 
your system hardware status. The newly installed A-Net Card 
should be displayed.

\

4  Go to the Patchbay page and click the Stage tab to verify 
that “A-Net Card” outputs appear in the patchbay.

5  In the standalone software, click the Devices tab on the Op-
tions page. You can right-click the SC48 graphic to see and 
modify your SC48’s input and output card configuration.

If the A-Net Card does not appear in the graphic, check the 
ribbon cable connection. Shut down your system, then dis-
connect and reconnect the ribbon cable to the Output Card, 
making sure to seat the connector properly in its card socket.

Detail of Devices tab indicating presence of an A-Net Card

Detail of the standalone software Devices tab showing an A-Net Card 
pop-up menu
Chapter 2: Installing an A-Net Card 7



Connecting A-Net Devices to the A-Net Card
With an A-Net Card installed in Mix Rack or the SC48, you can connect Aviom Pro16 Series networked devices in series or in par-
allel.

Connecting A-Net Devices in Series

You can connect any number of compatible A-Net devices in series by daisy-chaining the devices from the A-Net Card. Each 
Cat-5e cable connection can be up to 500 ft (150 m). There is no limit to the number of A-Net distributor devices or A-Net audio 
devices that can be used in a system. 

To connect A-Net devices in series:

1  Connect a Cat-5e Ethernet cable to the A-Net output connector on the A-Net Card. 

2  Connect the other end of the cable to the A-Net In port on the first device.

3  Use Cat-5e Ethernet cables to connect the “A-Net Out” port on each device to the “A-Net In” port on the subsequent device.

Connecting Aviom Personal Mixers in series (not to scale)

Cat-5e Ethernet cable
(Maximum length 500 ft/150 m)

A-Net Device 1 A-Net Device 2 A-Net Device 3 A-Net Device 4

(Additional A-Net devices)
AT16 A-Net Output Card Guide8



Connecting A-Net Devices in Parallel
You can connect compatible A-Net devices in parallel by connecting at least one A-Net distributor to the A-Net Card. Each Cat-5e 
cable connection can be up to 500 ft (150 m). There is no limit to the number of A-Net distributors or A-Net audio devices that 
can be used in a system. 

To connect A-Net devices in parallel:

1  Connect a Cat-5e Ethernet cable to the A-Net output connector on the A-Net Card. 

2  Connect the other end of the cable to the A-Net In port on an A-Net distributor device. Additional A-Net distributor devices 
can be connected in series to the first distributor device. 

3  Use a Cat-5e Ethernet cable to connect an A-Net Out port on the A-Net distributor device to the A-Net In port on the destination 
device.

Connecting Aviom Personal Mixers in parallel using an A-Net distributor (not to scale)

A-16D Pro Distributor

Cat-5e Ethernet cable
(Maximum length 500 ft/150 m)

A-Net Device 1

A-Net Device 2

A-Net Device 3

A-Net Device 4

A-Net Device 5 A-Net Device 7

A-Net Device 8A-Net Device 6
Chapter 2: Installing an A-Net Card 9
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Chapter 3: Using the A-Net Card

Overview
Each A-Net Card allows up to 16 channels of audio to be sent to any Aviom Pro16 Series networked device. Each Mix Rack can 
support up to two A-Net Cards, allowing for two discrete 16-channel networks.

Signal routing for A-Net Cards is configured in VENUE D-Show software.

A-Net Card

Signal Present/Status LEDs

The A-Net Card Signal Present/Status LEDs are arranged in channel pairs. These LEDs indicate the status of channel output signals 
as follows:

Connector

The Neutrik EtherCon connector accepts a standard Cat-5e Ethernet cable. The maximum recommended length for Cat-5e Ether-
net cable runs is 500 feet.

A-Net Card

Signal Present/Status LED Indications

LED Color Indication

Green Signal present

Yellow Test mode

Red Reset or Mix Rack hard mute

Signal Present/
Status LEDs

Neutrik Ethercon 
RJ 45 connector
Chapter 3: Using the A-Net Card 11



Stereo Linking Output Channels
You can automatically or manually link A-Net Card output 
channel pairs.

Linking Output Channels Automatically

You can set A-Net Card output channels to be automatically 
linked whenever a stereo output pair is assigned to a channel 
pair. This is called Auto Link.

Applicable output pairs include the following:

• Direct Outs from any stereo Input channel, stereo FX Re-
turn, or stereo Output bus

• Stereo-linked Auxes

• Stereo Groups

• Mains L-R

• Stereo PQ Outputs

Auto Link is on by default. In most routing scenarios it will be 
easiest to leave Auto Link on.

Linking Output Channels Manually

You can manually link A-Net Card output channel pairs.

To link output channels manually:

1  Go to the Patchbay page and click the Outputs or Directs 
tab.

2  Click the Stage tab to access the Mix Rack outputs.

3  Click the arrow icon beside the A-Net Card name and select 
from the following A-Net device pop-up menu options:

Auto Link Automatically links the card’s output channels 
when you assign a stereo-linked output pair (default)

Link All Links all of the card’s outputs channels

Link Outputs Links individual channel pairs on the card

Linking channels on an A-Net Card
AT16 A-Net Output Card Guide12
Linked channel pairs are indicated by an outline around the 
channel numbers in the Patchbay. 

To unlink output channels manually:

1  Go to the Patchbay page and click the Outputs or Directs 
tab.

2  Click the arrow icon beside the A-Net Card name and do one 
the following in the A-Net device pop-up menu:

• Select Unlink All

– or –

• Deselect a linked channel pair

Routing Signals to the A-Net Card
You can route Mains, PQ, Matrix, Aux, Group and Direct Outs 
output signals to the A-Net Card. You can route the Direct 
Outs from Input Channels, FX Returns and Outputs to the 
A-Net Card.

Routing Outputs to the A-Net Card

You can route Mains, PQ, Matrix, Aux and Group output sig-
nals to the A-Net Card.

To route output signals to the A-Net Card:

1  Go to the Patchbay page and click the Outputs tab.

2  Click the Stage Hardware tab above the patching grid.

3  To the left of the patching grid, click the tab to choose either 
the Mains, PQ, Matrix, Group or Aux output bus.

Indication of linked channels in the Patchbay

The A-Net Card appears as “A-Net Card” in the 
patchbay grid.



4  Click a box in the patching grid to assign the bus output 
(listed on the left) to an A-Net Card output (listed across the 
top).

Routing Direct Outs to the A-Net Card

You can route Input Channel, FX Return and Output Direct 
Outs to the A-Net Card.

To route Direct Outs to the A-Net Card:

1  Go to the Patchbay page and click the Directs tab.

2  Click the Stage tab above the patching grid.

3  To the left of the patching grid, click the tab to choose either 
the Channels Direct Outs, FX Returns Direct Outs or Outputs 
Direct Outs.

4  Click a box in the patching grid to assign a Direct Out (listed 
on the left) to the A-Net Card (listed across the top), The A-Net 
Card appears as “A-Net Card” in the patching grid.

Assigning an Aux output to an A-Net Card in the Patchbay Outputs page

If you installed an A-Net Card in Slot E of your Mix Rack, 
output 17 in the patchbay grid corresponds to channel one 
of the A-Net Card, output 18 corresponds to channel two, 
and so on up to output 32, which corresponds to channel 16 
of the A-Net Card.

Assigning an input channel Direct Out to an A-Net Card in the Patchbay 
Directs page

For more information on Direct Outs, see the VENUE 
D-Show Guide or VENUE D-Show Profile Guide.
Verifying the A-Net Card’s Outputs
You can verify the outputs of an A-Net Card by using its Test 
mode to send signals to all 16 outputs. Test mode sends a 
1 kHz tone directly from the card to all odd-numbered chan-
nels and a 2 kHz tone to all even-numbered channels on the 
card.

To enable Test mode for an AT 16 A-Net Output Card:

1  Make sure that no one is wearing headphones or in-ear 
monitors connected to the Aviom system before enabling Test 
Mode.

2  Put D-Show in Config mode.

3  Go to the Patchbay page and click the Outputs or Directs 
tab.

4  Click the tab for the Mix Rack that contains the A-Net Card.

5  Click the arrow icon beside the A-Net Card name and 
choose Test Mode in the AT16 A-Net device menu.

6  Click Enable Test Mode in the Test Mode dialog.

If multiple A-Net Cards are present, you will need to enable 
Test mode separately for each card. 

A dialog appears for each A-Net Card currently in Test Mode.

To disable Test mode:

Click Disable Test Mode in the Test Mode dialog.

Muting A-Net Card Channels Using the 
Events List
When you use the “Mute All Stage Outputs” action in the 
Events List, A-Net Card channels are muted in the same way as 
other Mix Rack outputs.

The “Mute All Stage Outputs” action also mutes the A-Net 
Card’s outputs during Test Mode.

When you place an A-Net Card in Test mode, any regular 
program material routed through the card is replaced with 
test tones. Test mode is intended as a troubleshooting tool 
and should not be enabled when performers are actively us-
ing an Aviom system.
Chapter 3: Using the A-Net Card 13
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Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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